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I Licensing

The HORTICOPIA * Image Gallery is licensed for a specific use and number of business

locations. The specifics are defined in the Licensing Agreement included with your copy of
the HORTICOPIA * Image Gallery.
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1| Installation

Software Installation

To start software installation, insert the HORTICOPIA * Image Gallery (Image Gallery) software
CD in your CD drive and follow the on-screen prompts. If the program does not start the
installation automatically, do the following:

e (Click on your Start menu and choose Run...

® Enter D:\ImageGallerySetup (change the drive letter if your CD drive is not on
drive D)
Important. Be sure to quit all virus checking software before starting the installation.
Your computer may need to be restarted during the installation if your system has not been
updated with current Microsoft software.

Installation Options

During installation, you will be asked if Previews should be installed on your hard drive.
The installation of the previews requires about 700 Mbytes of hard disk space and requires
up to 15 minutes to complete. There is a second CD that must be installed to make all the
previews accessible on your local system.

If you intend to use the Image Gallery only occasionally and want to save space on hard
drive space, do not choose the option to install the previews. This option will require that
your computer be connected to the Internet whenever you run the program. You can
change this option at a later time, by reinstalling the software and choosing to install the
previews at that time.

If you plan to use the Image Gallery on a regular basis and have plenty of hard disk space,
it'll be more convenient to install the preview images.

Hardware Key

A hardware key was shipped with the Image Gallery. The hardware key contains
information about the type of picture exports that have been licensed and the amount of
export credits you have.

You may browse the images without the hardware key, but the hardware key must be
inserted and recognized on your computer in order to add pictures to your lightbox and
export images.

Picture Libraries

Along with the Image Gallery software CD, you may have received one or more “picture
library” CDs. If you choose to install these CDs on your hard drive, the installation process
will take about 10 minutes per disk and will require approximately 650 Mbytes of hard disk
space.

It is not necessary to install the picture libraries. When you are ready to export pictures,
Image Gallery will first determine if the required picture library has been installed on your
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system. If it has not been installed, the image will be downloaded from the Internet or you
will be prompted to insert the CD during the export process. Only the requested images will
be copied from the CD, minimizing the amount of hard disk space required. This option
can be changed within the Image Gallery under the Tools menu by selecting/deselecting
Download Images from Internet.
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Il Using the HORTICOPIA ‘Image Gallery

Starting the Program

Be sure the hardware key is inserted in an available USB slot before starting the HORTICOPIA *
Image Gallery. If the hardware key is not detected, you will not be able to export images.
Double-click on the Image Gallery icon on your desktop to start the program. You may
also click on the Start menu, select All Programs, Image Gallery, and then within this
folder,. Image Gallery.

General Concepts

Exporting Images

The Image Gallery is divided into several categories which allows filtering of the plant list.
You purchased the right to export images from any of the categories along with a number of
image export credits. The export credits may be applied to any image in the various
categories. Please note that the price for exporting each image appears along with the
preview. While most exports are the same amount, there may be some specialty photographs
which have a different price.

All exported images are stored in your current export folder. The export folder is set from
the File menu’s Export Folder... option. You also specify the export format desired with
this option, choosing bitmap, JPEG, or TIFF format

Exporting images in the Image Gallery is a two-step process.

Lightbox

First step, select images you are interested in without committing to exporting them. The
selected images are saved in a /ightbox that you can view at any time, and the images selected
are kept between sessions. Images may be removed from the lightbox if you decide not to
export them.

Export Folder

Second step is to click on Export Images and all images appearing in the lightbox will be
exported. The export folder and export format may be changed at any time and the next
time you export, the new folder and/or format will be used.
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Functional Overview
-l x]

File Edit Tools Help

Plant List Filters Shaow
Trees Perennials Aguatics & Marginals Conifers Ferrs Lighthosx

Shrubs Anriuals Interior Palms Grasses
= i Comman
Groundcavers Bierials Clear List_| Waoody Wines Succulents Mames
Botanical Name Iﬁ!

Ahelia ¥ 'Edward Goucher'

| |Abelia chinensis

| |&belia x grandifiora

| |&belia x grandifiora ‘Compacta’

| |Abelia % grandifiora ‘Francis Mason'

| |&belia x grandifiora 'John Creech’

| |Abelia x grandifiora ‘Prostrata’

| |Abelia x grandifiora ‘Sunrise’

| |2belia longituba -—-see Abelia schurmannii

| |Abela mosanensis

| |Abelia schumanni

Ahelia schurnani ‘Burnblebee’

Abhelia zanderi 'Conti (Confetti™)'

| |2belia zanderi ‘Sherwoodi’

|| Abeliophyliurm distichum %

| |Abeliophyllum distichum ‘Roseumn’

| | Abelmoschus esculentus

| [Abelmoschus esculentus ‘Burgundy'

| |Abelmaschus esculentus ‘Cream Cup’

| | Abelmoschus esculentus "Little Lucy”

| |Abelmoschus manihot

| |Abelmaschus moschatus ‘Pacific Pink'
Abelmoschus moschatus ‘Pacific Scarlet’
Abelmoschius moschatus ‘Pacific Scarlet Orange’
Ahies aba

| |2hies alba 'Green Spiral’

| |Abies amabilis

| |&hies arizonica ---see Ahies lasiocarpa ssp. arizonica
| |Ahies balsarea

Ahies bornmuelleriana ---see Abies nordmanniana
| | Ahies bracteata

| |Ahies cephalonica Ll

| 14,353 plants | [$0left |1 lightbox images | ¢ 8.00 lighthax cost 11232005 4

Plant List Filters

The plant list shows only the plants belonging to the filters that have been selected. If no
filter has been chosen, it is the same as if all filters have been selected.

There is a certain amount of overlap among plant filters. That is, a given plant may belong
to more than one group.

Switching List Order

You may view plants in either botanical or common name order. Just click on the Common
Names button to switch list order. Once you are in common names mode, the button will
read Botanical Names.

Switching to the Lightbox

To switch to the lightbox view, click on the Show Lightbox button. To return to the main
list, click on Show Plant List.
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Plant List

You can scroll through the plant list or type the first few characters of a plant name to let the
list automatically advance to the your area of interest. If a plant name is selected, the preview
images for that plant will appear in the preview pane on the right.

In botanical name order, you may see some entries followed by the notation —see planr
name. Since botanical names sometimes change, we have included cross-references to
previously used terminology where it is available.

Status Bar
At the bottom of the main screen is a status bar that contains the following information:
e Number of plants in the currently filtered list

e Number of images available for the currently selected plant; this entry is empty if no
image is selected

¢ Amount of credits remaining for exporting images
¢ Number of images in the lightbox
¢ Cost of exporting the images currently in then lightbox

Viewing Available Images

After you click on a plant name, you will see the images available for the selected plant. Each
image for the plant will appear in a box as follows:

[ Save in lightbox for export Code: B

Note that the screened Preview appears only in the previews. The exported image will have
no screening or markings.

If the image has been previously exported, the “save in lightbox for export” will be in red
lettering and the word export will be changed to “re-export.” Note that the Image Gallery
cannot retrieve previously exported images that you have lost.

Be sure to scroll through all the images to get a complete overview of the image availability
for a plant.

Click on Save in lightbox for export to place the image in the lightbox.
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Working with the Lightbox

E Horticopia Image Gallery

File Edit Tools Help
Ima%: | | | e | e ‘ Sty Plant List \ Export Images |
M
Mew Look' Plurne Celosia #3 Surnrmer Phlox ‘Mora Leigh' #2
b
11,047 plants $ 400 left 4 lightbox images | $ 32.00 lightbox co 10/6f2002

Selecting an Image

You may select an image by either clicking on the image preview or the name of the image
below the preview. In either case, the background of the name field changes to green to
indicate the image has been selected.

Cropping

Once an image has been selected, it may be cropped. Just place the mouse cursor on the
selected image, then hold down the mouse and drag to create a cropping rectangle.

The current cropping selection specified in the Tools menu determines the nature of the
cropping. Variable cropping means that you simply drag to create a selection rectangle. If
you selected fixed aspect cropping the relationship between the horizontal and vertical size
of the cropping rectangle will remain constant. This lets you easily crop images to fit a
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predetermined rectangle. The aspect ratio may be changed with the tools menu’s Change

Aspect Ratio...
Rernove ' Reset
"Image # EF * ‘* Zrop

Once you have established a cropping region, you may move the cropping rectangle by using
the four directional arrow cursor buttons. You may also reset (deselect) the cropping region,

if desired.

Exporting

The Image Gallery suggests an export name for each image based on the botanical name of
the plant and the image position. You are free to change the export name by entering a
different name in the text box below the image.

When the image is exported, it will be appended with a suffix appropriate to its export
format -- .bmp, .jpg, or .tif.

When you click on the Export Images button, the images will be exported. If necessary, you
will be prompted to insert the appropriate image CD required for exporting. As each image
is exported, the remaining export credits will be adjusted to reflect the cost of the export.
Exporting will continue until either there are no images remaining for export, or there are
insufficient export credits remaining.

Returning to the Plant List

Click on Show Plant List to return to the plant list. You may make additional selections at
that time and return to the lightbox at a later time. All entries in the lightbox, including
export names and cropping selections, are retained even if you exit and restart the Image

Gallery.

Adding Credits and Categories

From time to time you may wish to purchase additional export credits. Clicking on the
Tools menu and selecting Update Hardware Key... accomplishes this process.
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futhorizations

Fequest Code: | 1983452861

Identification Code: | 1595740526

Autharization 1; | - |

Autharization 2: | - |

Autharization 3 | - |

Reset (0] Cancel |

Both the Request Code and the Identification Code need to be communicated to
Horticopia, Inc. so that additional credits or libraries may be added to the hardware key.
This process is usually done over the telephone, but it’s also possible to simply note the
two codes and provide them to Horticopia. It is very important to not click Reset unless
you really want to generate a new request. If you are submitting the codes to Horticopia,
wait until you receive your authorization codes before clicking on reset. You may
continue to use the program until you receive the codes. At that time, you may return to
the Update Hardware Key and enter your codes.
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IV Additional Information

In addition to this User Guide, Image Gallery provides extensive on-line information on
using the product effectively and on solving potential problems.

On-line Help

The on-line help is accessed within HORTICOPIA “by selecting the appropriate item from the
Help menu. The on-line help may also be viewed without starting the Image Gallery by
clicking on the Start menu, then Programs, followed by Image Gallery, and finally
Horticopia Image Gallery Help (Start->Programs->Horticopia Image Gallery->Horticopia
Image Gallery Help).

HORTICOPIA Web Site

HORTICOPIA s web site is at http://www.horticopia.com

We have a section devoted to technical support. You can access this section directly at
http://www.horticopia.com/techsupp. If you have any questions that aren’t answered by this
User Guide or the on-line help, take a look at our web site for up-to-the-minute
information. You can also e-mail our technical support staff from the web page.

Contacting HORTICOPIA

Horticopia, Inc. provides HORTICOPIA-specific technical support to registered users. If
you have problems with Windows, your computer system, or other software, please contact
the vendors of those products.

Our technical support staff will be happy to assist you with any problems you experience
installing or running the Image Gallery. Please read this User Guide and refer to the on-
line help before contacting Technical Support. You should also access our web site at
www.horticopia.com to see if there are any updates or technical memos.
When contacting us for technical support by e-mail, be sure to include the following
information:
1. Name and telephone number, along with hours at which you may be reached.
2. Type of system you are running (Windows 2000, XP or later).
3. Version of the HORTICOPIA software you are using (under the
HORTICOPIA Help menu, select About.. to get the version number).
4, Description of the problem, including what actions you took to cause the
problem to occur.
Send e-mail to support@horticopia.com. We will usually get back to you the same day.
To contact us by telephone, call (540) 338-9147 between 9:00 AM and 5:00 PM Eastern
time, Monday through Friday. Please note that we do not provide technical support on our
toll free sales and information lines.
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V  Copyrights and Trademarks

HORTICOPIA" products are protected by copyright and trademark laws. This chapter
explains how the copyright laws apply to your use of the Image Gallery.

HORTICOPIA Trademarks
HORTICOPIA and Garden Workbench are registered trademarks of Horticopia, Inc.

Other Trademarks

Microsoft and Windows are registered trademarks of Microsoft Corporation. Adobe
Acrobat is a registered trademark of Adobe Corporation.

Copyrights

All software, pictures, data and accompanying material are copyrighted. Copyright laws and
international copyright treaties, as well as other intellectual property laws and treaties protect

this information.
Your software license accompanying the HORTICOPIA * Image Gallery defines the permissible
use of the images in HORTICOPIA * Image Gallery.

Examples of Prohibited Use

The following uses of HORTICOPIA * Image Gallery images are always prohibited unless you
have prior written permission from Horticopia, Inc. This list of prohibited uses is only a
sample and is not to be construed as complete.

®  You may not sell any images or products containing pictures derived from the

HORTICOPIA * Image Gallery.

®  You may not use any images or data from HORTICOPIA * /mage Gallery on
websites,
newspapers and magazines with a national/international circulation,
product catalogs, or
commercially printed materials and publications.

O O O O

® You may not display photographs or other information as a photography exhibit or
any other fashion not incidental to your normal use.
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